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Legal Notices

Warranty

The only warranties for HP products and services are set forth in the express warranty statements 
accompanying such products and services. Nothing herein should be construed as constituting an additional 
warranty. HP shall not be liable for technical or editorial errors or omissions contained herein.

The information contained herein is subject to change without notice.

Restricted Rights Legend

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent 
with FAR 12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and 
Technical Data for Commercial Items are licensed to the U.S. Government under vendor's standard 
commercial license.

Copyright Notices

© Copyright 2002 - 2007 Hewlett-Packard Development Company, L.P.

Trademark Notices

Java™ is a US trademark of Sun Microsystems, Inc.

Windows® and Windows NT® are US registered trademarks of Microsoft Corporation. 

Oracle® is a registered US trademark of Oracle Corporation, Redwood City, California. 

UNIX® is a registered trademark of The Open Group.
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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://ovweb.external.hp.com/lpe/doc_serv/ 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP software support web site at:

http://support.openview.hp.com/support.jsp 

HP Software online support provides an efficient way to access interactive technical support tools. As a valued 
support customer, you can benefit by using the support site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels and HP Passport, go to:

http://support.openview.hp.com/new_access_levels.jsp 
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1 Overview
This chapter covers the following topics:

• Performance Insight and SAA

• Enhancements in Version 3.1

• Data collection

• Sub-packages, folders, and reports

• Integration with Network Node Manager

• Ways to customize reports

• Sources for additional information

Performance Insight and SAA

HP Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/OVPA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks

• Easy assessment of capacity trends

• Accurate and timely documentation for management

The following text is borrowed from a white paper from Cisco Systems:

SAA is an embedded, synthetic performance-monitoring tool to measure service 
performance from the network perspective. Because SAA is embedded in Cisco IOS 
Software, it is platform independent from all Cisco routers and switches running Cisco 
IOS Software.
7



Because SAA is an intelligent agent embedded in the router, it provides only raw 
statistics. The programmatic interface allows an external application to configure and 
retrieve performance metrics. The external application can then use the metrics to 
analyze and present the measurements graphically, as well as to generate service-level 
monitoring reports.

The raw statistics generated by SAA are stored in the CISCO-RTTMON-MIB. Performance 
Insight is an external application. It polls the MIB, processes collected data in accordance 
with directives from the Service Assurance Report Pack, and generates statistics for the 
following metrics:

• Response time — round-trip time for specific SAA tests

• Exception counts — number of SAA tests that exceeded the threshold for response time

• Availability — the ratio of successful SAA tests to total tests

• Jitter — variation in the packet inter-arrival time

• Throughput — an estimate of the bytes per second transmitted during an SAA test

• Number of transactions — number of SAA tests completed

• Traffic volume — number of bytes sent and received by an SAA source device

• MOS — estimated Mean Opinion Score for VoIP tests

Enhancements in Version 3.1

Version 3.1 includes new features, new upgrade packages, and a defect fix. In addition, there 
are new versions of the datapipes that collect data for Service Assurance. For details about 
the enhancements that were made to previous releases of Service Assurance, see Appendix A, 
Version History.

New Features

• Location Independent Reporting (LIR)

• Rate data removed from NRT reports, top-level table

• Report format updates

New Upgrade Packages for the Report Pack

• UPGRADE_Service_Assurance_to_31

• UPGRADE_Service_Assurance_Location_to_31

• UPGRADE_Service_Assurance_NRT_to_21

New Upgrade Packages for Datapipes

• UPGRADE_CiscoSAA_Datapipe_to_58

• UPGRADE_CiscoSAA_NRT_Datapipe_to_24

• UPGRADE_ServiceAssuranceRFC2925_Datapipe_to_11

Defect Fix

• QXCR1000348212
8 Chapter 1



Data Collection

The following datapipes collect data for Service Assurance:

• Cisco SAA Datapipe 

• Cisco SAA NRT Datapipe 

• Service Assurance RFC2925 Datapipe 

The Cisco SAA Datapipe and the Cisco SAA NRT Datapipe collect data from any active SAA 
device that is running Cisco IOS 12.0.5(T) or later and supports the CISCO-RTTMON-MIB. 

The ServiceAssurance_RFC2925_Datapipe collects data from devices that support the RFC 
2925 MIB, defined by the MIB file DISMAN-PING-MIB.mib. 

Installing at least one datapipe is mandatory. The following table indicates which collection 
tables are polled by each datapipe.

Datapipe MIB Collection Tables

Cisco SAA Datapipe CISCO-RTTMON-MIB • RttMonCntlAdminTable
• RttMonEchoAdminTable
• RttMonStatsCaptureTable
• RttMonStatsTotalsTable
• RttMonHTTPStatsTable
• RttMonJitterStatsTable

Cisco SAA NRT Datapipe CISCO-RTTMON-MIB • rttMonCntlAdminTable
• rttMonEchoAdminTable
• rttMonLatestRttOperTable
• rttMonLatestHTTPOperTable
• rttMonLatestJitterOperTable

RFC2925 Datapipe RFC2925 MIB • PingCtlTable
• PingResultsTable
• PingProbHistoryTable

Cisco modified the way it records MOS values. The original value range went from 1 to 5. 
According to Cisco revision 200305210000Z, the range now goes from 100 to 500. This change 
affects the following values:
• rttMonLatestJitterOperMOS
• rttMonJitterStatsMinOfMOS
• rttMonJitterStatsMaxOfMOS
The VoIP Near Real Time - Latest Test report includes a chart that tracks MOS over the 
previous 24 hours for a selected SAA test. The range of values in the graph will vary 
depending on which version of the CISCO-RTTMON-MIB is being polled by the Cisco SAA 
NRT Datapipe.
Overview 9



NRT Reports

If you install the Cisco SAA Datapipe and nothing else, you will have one NRT report, the 
NRT Summary report in the Source-Destination-Application folder. If you install the Cisco 
SAA Datapipe and the Cisco SAA NRT Datapipe, you will get three additional NRT reports: 

• Near Real Time - Latest Test

• Jitter Near Real - Latest Test

• VoIP Near Real Time - Latest Test

You can configure the polling frequency of the Cisco SAA NRT Datapipe. Because the Service 
Assurance Agent may conduct tests at a frequency that varies from test to test, the polling 
frequency should not be faster than the testing rate. The maximum polling rate is once every 
5 minutes.

Metrics Collected by the RFC2925 Datapipe

The RFC2925 Datapipe collects the following ICMP ECHO test results from Juniper, 
Riverstone, and Netbridge devices:

• Average round-trip time

• Sum of square of round-trip time 

• History-related statistics

These metrics are used to calculate statistics for:

• Availability

• Exception count

• Throughput between devices

The RFC2925 Datapipe does not collect data related to jitter and http test. If the RFC2925 
Datapipe is the only datapipe you install, the following reports will be empty:

• SAA_Jitter_Destination Summary

• SAA_Jitter__Source Summary

• SAA_Jitter_Source_And_Destination Summary

• SAA_Jitter NRT-Latest Test

• SAA_VoIP NRT-Latest Test

Configuring Routers for SAA Operations

The Service Assurance Agent cannot operate unless you configure it. Although the command 
line interface for IOS provides a way to configure SAA operations, run SAA operations, and 
view statistics, this approach to SAA configuration is awkward and slow, especially when 
multiple routers are involved. The Cisco SAA Datapipe includes a configuration utility that 
makes this task easier. You can use this utility to define which operations are conducted, the 
frequency of the operation, and the destination. For more information, see Chapter 4, Router 
Configuration.
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Sub-Packages, Folders, and Reports

Service Assurance includes multiple sub-packages. Each sub-package (except Thresholds) 
contains report templates, tables, and processing directives for OVPI. Installing the Service 
Assurance sub-package is mandatory. The other sub-packages are optional. If you install just 
the Service Assurance sub-package, you get the following report folders:

• Application

• Customer

• Destination

• Jitter

• Source

• Source / Destination / Application

If you install the Location sub-package, you also get the location-oriented reports in the 
Location report folder; if you install the NRT sub-package, you will get three additional Near 
Real Time reports in the NRT folder.

The following table provides a list of the reports in each folder.

Folder Reports

Application • Application Exceptions by Source/Destination
• Application Forecast
• Application Forecast by Source/Destination
• Application Summary
• Application Top Ten

Customer • Customer Forecast
• Customer Summary
• Customer Top Ten

Destination • Destination Exceptions by Source / Application
• Destination Forecast
• Destination Forecast by Source / Application
• Destination Summary
• Destination Top Ten

Jitter • Jitter Destination Summary
• Jitter Source/Destination Summary
• Jitter Source Summary

Location • Application Exceptions by Location / Destination
• Application Forecast by Location / Destination
• Destination Exceptions by Location / Application
• Destination Forecast by Location / Application
• Location Summary
Overview 11



Following is a brief description of each generic report.

Exception. Shows elements that exceeded the predefined response time threshold during the 
previous day. The element can be a source, a destination, an application, or a location. Does 
not include jitter test results. 

Summary. Displays aggregations of performance data for a particular perspective—a source, 
a destination, an application, a location, or a customer. Helps you identify anomalies and 
performance trends within the element group. Does not include jitter test results. 

Forecast. Presents a summary of response time and throughput forecasts from different 
perspectives. Identifies the applications, sources, destinations, locations, or customers that 
are likely to have response time or throughput problems in the near future. Does not include 
jitter test results. Although some data will appear in forecast reports a few days after you 
install Service Assurance, reliable forecasting will not be available until the initial baseline is 
complete, about thirteen weeks after installation.

Top Ten. Identifies ten elements ranked by response time, throughput, and rate of change. 
Provides data tables for worst response time, projected response time, worst throughput, 
projected throughput, most transactions, and most traffic. Does not include jitter test results.

Near Real Time. Available in two flavors. The report in the Source/Destination/Application 
folder is produced from hourly data collected by the Cisco SAA Datapipe. This report provides 
a list of source/destination/application combinations with high exception counts. Updated 
hourly, this report also provides hourly and daily data for response time, throughput, 
transactions, traffic, exceptions, and availability. The three reports in the optional Service 
Assurance NRT module contain data collected by the Cisco SAA NRT Datapipe. These reports 
can be updated more frequently, as often as every 5 minutes.

Jitter. Displays total jitter tests and response time exceptions for each customer and 
deviation statistics for all devices belonging to each customer. Monitors response time, packet 
error types, deviation, and packet loss. Includes jitter test results only.

Location • Location Exceptions by Application / Destination
• Location Forecast
• Location Forecast by Application / Destination
• Location Top Ten

Source • Source Exceptions by Application / Destination
• Source Forecast
• Source Forecast by Application / Destination
• Source Summary
• Source Top Ten

Source/Dest/App • Near Real Time Summary (collections once an hour)
• Source Destination Application Summary

NRT • Near Real Time - Latest Test
• Jitter Near Real - Latest Test
• VoIP Near Real Time - Latest Test

Folder Reports
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Integration with Network Node Manager

If you use NNM as well as PI, you have the option of improving your ability to diagnose 
problems by integrating PI with NNM. To integrate them, enable integration on NNM (by 
running a script) and use the Integration Wizard on PI to provide PI with information about 
your NNM server. 

If NNM and PI are integrated, be sure to install the optional thresholds sub-package that 
comes with Service Assurance. Installing the optional thresholds sub-package configures the 
Thresholds Module to respond to breach conditions by taking one of several possible actions in 
accordance with category, severity, and destination parameters. The default response is to 
send a breach trap to NNM. The breach trap received by NNM becomes an alarm in the NNM 
alarm browser. In response to the alarm, the NNM operator can open the Near Real Time 
report in the Source/Destination/Application folder. 

You are not required to configure the Thresholds Module. You do not need to define an action 
or specify a destination for breach traps. However, you are free to modify category, severity, 
and destination parameters at any time. For details about these options, see the Thresholds 
Module User Guide.

Options for Customizing Reports

Service Assurance reports can be customized by applying group filters, by importing 
properties (customers and locations), by applying constraints, and by editing tables and 
graphs. If you intend to share reports with customers, you will use group filters to produce 
customer-specific reports. Any user can apply constraints to a report, or edit tables and 
graphs. For more information about view options for tables and graphs, see Appendix B, 
Editing Tables and Graphs.

Group Filters

If you intend to share your reports with customers, you will need to produce customer-specific 
reports. Creating customer-specific reports involves the following tasks:

• Importing customers and locations using Common Property Tables

• Creating a group account for all of the users affiliated with a particular customer

• Creating a group filter for the group account

For more information about group filters, see the PI Administration Guide. 

Importing Property Data

The Cisco SAA Datapipe populates Service Assurance reports with SAA tests and IP 
addresses (or DNS names) for source and destination routers. Tests, addresses, and DNS 
names appear automatically. If you want to associate a customer and a location with a device, 
you must import this information yourself. To do that, use the change forms that come with 
Common Property Tables, or use the property import utility that comes with the Common 
Property Tables.

Until recently, integrating NNM and OVPI meant that you had to install packages on NNM 
and OVPI. This step is no longer necessary.
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Editing Parameters

Editing a parameter applies a constraint that filters out data you are not interested in seeing. 
For example, if you edit Customer Name, data for every customer except the customer you 
typed in the Customer Name field drops from the report. You may apply multiple constraints 
at once. Service Assurance supports the following parameters:

• Customer Name

• Customer ID

• Source Name

• Source Location

• Destination Name

• Destination Location

• Application (SAA test type)

• ToS (Type of Service)

• Tag (Test Tag defined in the source router)

If you are using the Web Access Server to view reports remotely, edit parameters by clicking 
the Edit Parameters icon at the bottom right-hand corner of the report. When the Edit 
Parameters window opens, enter the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK.

Sources for Additional Information

This user guide provides samples of some of the reports in Service Assurance. The demo 
package that comes with Service Assurance contains a sample of every report in the package. 
If you have access to the demo package and you want to know what fully-populated reports look 
like, install the demo package. Like real reports, demo reports are interactive. Unlike real 
reports, demo reports are static.

The following documents are related to this user guide:

• Service Assurance Report Pack Release Notes

• Cisco SAA Datapipe Release Notes

• Cisco SAA NRT Datapipe Release Notes

• Service Assurance RFC2925 Datapipe Release Notes

• PI Report Packs, CD-ROM Release Notes, October 2007

Manuals for PI and the reporting solutions that run on PI can be downloaded from the 
following web site:

http://ovweb.external.hp.com/lpe/doc_serv/ 

The user guides for OVPI are listed under Performance Insight. The user guides for report 
packs and datapipes are listed under Performance Insight Report Packs. Every manual indicates 
a date. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, we recommend checking this site for updates.
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2 The Upgrade Install
This chapter covers the following topics: 

• Guidelines for a Smooth Upgrade

• Distributed Environments

• Upgrading Service Assurance

Guidelines for a Smooth Upgrade

The report pack CD-ROM contains report packs, datapipes, and several shared packages. 
When you insert the report pack CD in the CD-ROM drive and start the package extraction 
program, the install script extracts every package from the CD and copies the results to the 
Packages directory on your system. When the extract finishes, the install script prompts you 
to launch OVPI and start Package Manager. Before using Package Manager, review the 
following guidelines.

Prerequisites for the Upgrade

The following software must be installed before upgrading (you may have only one of the 
datapipes installed):

• Performance Insight 5.3

• Any available service pack for PI 5.3

• Service Assurance 3.0

• Service Assurance Location 3.0

• Service Assurance NRT 2.0 (optional)

• Cisco SAA Datapipe 5.7

• Cisco SAA NRT Datapipe 2.3

• Service Assurance RFC2925 Datapipe 1.0

You can find information about OVPI service packs, including installation instructions, in the 
release notes issued with the service pack. 

Upgrading Common Property Tables

If you are running an older version of Service Assurance on any server, you are probably 
running an older version of Common Property Tables. This release of Service Assurance 
requires Common Property Tables 3.7. If you have an earlier version installed, you can easily 
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install the “to 3.7” upgrade package. When you do that, do not install the upgrade package 
and other packages at the same time. Install the upgrade package for Common Property 
Tables and only the upgrade package for Common Property Tables.

Datapipes and Remote Pollers

When you uninstall an existing datapipe, the following information is lost:

• Single polling policy for a remote poller

• Cloned polling policies for multiple remote pollers

• Customized polling groups 

To prevent this information from being lost, you can export existing polling policy 
configurations and customized polling groups by using the following commands:

• collection_manager

• group_manager 

Exporting Polling Policy Configurations

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst

Windows: As Administrator, launch a command window. Navigate to the OVPI install 
directory and execute the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst

Exporting Polling Group Configurations

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, execute the following command: 

cd $DPIPE_HOME

./bin/group_manager -export_all -outfile /tmp/savePollingGroups

Windows: As Administrator, launch a command window, then navigate to the OVPI install 
directory and execute the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups

Custom Table Views

If you created one or more custom table views, the views you created may interfere with the 
report pack upgrade, causing the process to fail. Whether your custom table views interfere 
with the upgrade depends on how you created them. If you created them using SQL, the 
upgrade will succeed, however, your custom views will not be available once the upgrade is 
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complete. If you created them using Datapipe Manager, the upgrade is likely to fail. To 
prevent the upgrade from failing, delete your custom table views before you upgrade the 
report pack, then recreate them after the report pack is upgraded.

Installing Service Assurance NRT 2.0

The Service Assurance NRT 2.0 sub-package includes one new report and modifications to two 
existing reports. There is no upgrade path. If you want to install version 2.0, first delete 
version 1.0, then install version 2.0. 

Distributed Environments

If you are running Service Assurance as a distributed system, the central server, every 
satellite server, and every remote poller must be running the same version of OVPI and all 
available Service Packs. Follow these steps to upgrade a distributed system:

1 Disable trendcopy on the central server.

2 For the central server:

• Upgrade Common Property Tables, if necessary

• Install the upgrade packages for the report pack and sub-packages; deploy reports.

3 For each satellite server:

• Upgrade Common Property Tables, if necessary

• Install the upgrade packages for the report pack and datapipes

4 Re-enable trendcopy on the central server.

5 Reconfigure you central server and each satellite server. For details, see Setting Up a 
Distributed System on page 34.

Upgrading Service Assurance

Perform the following tasks to upgrade to Service Assurance 3.1:

• Task 1: Stop OVPI Timer and extract packages from the product CD

• Task 2: Upgrade to Common Property Tables 3.7

• Task 3: Install the upgrade packages for the report pack and datapipes

• Task 4: Restart OVPI Timer

Task 1: Stop OVPI Timer and extract packages from the product CD

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:
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HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a main menu appears 
automatically. On UNIX, mount the CD, navigate to the top level directory on the CD, and 
run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens.

Once the copy to the Packages directory is complete, you have the option of navigating to the 
Packages directory to see the results. The Packages directory contains separate folders for 
Service Assurance and each datapipe. The following folders appear under Service Assurance:

• Service_Assurance.ap

• Service_Assurance_Demo.ap

• Service_Assurance_Location.ap

• Service_Assurance_NRT.ap

• Service_Assurance_Thresholds.ap

• UPGRADE_Service_Assurance_to_31.ap

• UPGRADE_Service_Assurance_Location_to_31.ap

• UPGRADE_Service_Assurance_NRT_to_21.ap

The following folder appears under Cisco SAA Datapipe:

• CiscoSAA_Datapipe.ap

• CiscoSAA_NRT_Datapipe.ap

• UPGRADE_CiscoSAA_Datapipe_to_58.ap

• UPGRADE_CiscoSAA_NRT_Datapipe_to_24.ap

The following folder appears under RFC2925 Datapipe:

• ServiceAssuranceRFC2925_Datapipe.ap

• UPGRADE_ServiceAssuranceRFC2925_Datapipe_to_11.ap

Task 2: Upgrade to Common Property Tables 3.7

If you have not already upgraded to Common Property Tables 3.7, do it now. When you do this 
upgrade, do not install other packages at the same time. Install the upgrade package for 
Common Property Tables and only the upgrade package for Common Property Tables. If you 
need help with the upgrade, refer to the Common Property Tables User Guide. 

Task 3: Install the upgrade packages for the report pack and datapipes

1 Start Package Manager. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory, or select a different directory if 
necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port. Type your user name and 
password for the OVPI Application Server. 
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5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

Service_Assurance_Location (optional)

UPGRADE_Service_Assurance_to_31

UPGRADE_Service_Assurance_Location_to_31

UPGRADE_Service_Assurance_NRT_to_21 (optional)

UPGRADE_CiscoSAA_Datapipe_to_58 (if this datapipe is installed)

UPGRADE_CiscoSAA_NRT_Datapipe_to_24 (if this datapipe is installed)

UPGRADE_ServiceAssuranceRFC2925_Datapipe_to_11 (if this datapipe is installed)

7 Click Next. The Type Discovery window opens. Disable the default.

8 Click Next. The Selection Summary window opens.

9 Click Install. The Installation Progress window opens and the install begins. When 
installation finishes, an install complete message appears.

10 Click Done.

Task 4: Restart OVPI Timer

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Do not be surprised if the upgrade package you just installed seems to have 
disappeared. The install wizard displays what you just installed as Service 
Assurance 3.1. This is not an error.
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3 The New Install
This chapter covers the following topics: 

• Guidelines for a smooth install 

• Installing the report pack

• Accessing deployed reports

• New object categories in the object model

• Package removal

Guidelines for a Smooth Install

The report pack CD-ROM contains report packs, datapipes, and several shared packages. 
When you insert the report pack CD-ROM in the CD-ROM drive and launch the package 
extraction program, the install script extracts every package from the CD and copies the 
results to the Packages directory on your system. When the extract finishes, the install script 
prompts you to launch PI and start Package Manager. Before running Package Manager, 
review the following guidelines.

Core Product Prerequisites

The following software must be installed before installing Service Assurance:

• Performance Insight 5.3

• All service packs available for PI 5.3

You can find information about each service pack, including installation instructions, in the 
release notes that were issued with the service pack. 

RFC2925 Datapipe Prerequisites

Before installing packages, configure at least one RFC2925 device for a set of ping tests. You 
may configure ping tests after you install the Service Assurance Report Pack and the 
RFC2925 Datapipe. If you configure ping tests after you install the packages, make sure that 
you include the router in PI’s polling list by running the trend_discover –t command.
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Upgrading Common Property Tables

If you are running an older version of Common Property Tables, upgrade to version 3.7. 
Installing the upgrade package is no different from installing other upgrade package, 
however, do not install the upgrade for Common Property Tables and other packages at the 
same time. Install the upgrade package for Common Property Tables and only the upgrade 
package for Common Property Tables. 

Integration with NNM: Threshold Alarms

If OVPI and NNM are integrated, you have the option of launching Service Assurance reports 
from NNM in response to threshold breaches detected by OVPI. To take advantage of this 
feature, install the thresholds sub-package, Service_Assurance_Thresholds. 

Service_Assurance_Thresholds provides default threshold settings. The thresholds 
sub-package cannot operate without the Threshold and Event Generation Module, commonly 
known as the Thresholds Module. If you select the thresholds sub-package for installation, 
Package Manager will install the Thresholds Module for you, automatically.

Distributed Environments

If you are running Service Assurance as a distributed system, the central server, every 
satellite server, and every remote poller must have OVPI 5.2 installed. Following is an 
overview of the installation procedure for distributed environments:

1 Disable trendcopy on the central server.

2 Install the following packages on the central server:

• Service Assurance 3.1; deploy reports.

• Service Assurance Location 3.1

• Service Assurance Thresholds (optional)

• Service Assurance NRT (optional)

3 Install the following packages on each satellite server (at least one datapipe must be 
installed):

• Service Assurance 3.1

• Service Assurance NRT (optional)

• Cisco SAA Datapipe 5.8

• Cisco SAA NRT Datapipe 2.4

• Service Assurance RFC2925 Datapipe 1.1

4 Re-enable trendcopy on the central server.

After the installation is complete, you must configure the central server and each satellite 
server. These steps are covered in Setting Up a Distributed System on page 34.
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Installing Service Assurance 

Perform the following tasks to install Service Assurance:

• Task 1: Extract packages from the report pack CD

• Task 2: Upgrade to Common Property Tables 3.7

• Task 3: Install Service Assurance, the datapipes, and optional sub-packages

— Service_Assurance 3.1

— Cisco_SAA_Datapipe 5.8

— Cisco_SAA_NRT_Datapipe 2.4

— ServiceAssuranceRFC2925_Datapipe 1.1

If desired, install the optional sub-packages when you install the report pack.

Task 1: Extract packages from the report pack CD 

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI Timer and wait for processes to terminate.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays 
automatically. On UNIX, the CD may or may not mount automatically; if it does not 
mount automatically, navigate to the top level directory on the CD, and run the ./setup 
command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager install wizard opens.

When the copy to the Packages directory is complete, you can navigate to the Packages 
directory to see the results. The Packages directory contains separate folders for Service 
Assurance and each datapipe. The following folders appear under Service Assurance:

• Service_Assurance.ap

• Service_Assurance_Demo.ap

• Service_Assurance_Location.ap

• Service_Assurance_NRT.ap

• Service_Assurance_Thresholds.ap

• UPGRADE_Service_Assurance_to_31.ap

• UPGRADE_Service_Assurance_Location_to_31.ap

• UPGRADE_Service_Assurance_NRT_to_21.ap
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The following folder appears under Cisco SAA Datapipe:

• CiscoSAA_Datapipe.ap

• CiscoSAA_NRT_Datapipe.ap

• UPGRADE_CiscoSAA_Datapipe_to_58

• UPGRADE_CiscoSAA_NRT_Datapipe_to_24

The following folder appears under ServiceAssuranceRFC2925 Datapipe:

• ServiceAssuranceRFC2925_Datapipe.ap

• UPGRADE_ServiceAssuranceRFC2925_Datapipe_to_11.ap

You may ignore the upgrade packages. Installing the demo package is optional. You may 
install the demo package by itself, with no other packages, or you may install the demo 
package along with everything else. 

Task 2: Upgrade to Common Property Tables 3.7

If you are not running any version of Common Property Tables, let Package Manager install 
Common Property Tables for you. If you are an earlier version, upgrade by installing the “to 
3.7” package. Do not install other packages when you do this; install the upgrade package for 
Common Property Tables and only the upgrade package for Common Property Tables.

Task 3: Install Service Assurance, the datapipes, and optional sub-packages

1 Start Package Manager. The Package Manager install wizard opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory, or select a different directory if 
necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port. Type your user name and 
password for the OVPI Application Server. 

5 Click Next. The Package Selection window opens. Click the check box next to the following 
packages (at least one datapipe must be installed):

Service_Assurance

Service_Assurance_Location

Service_Assurance_NRT

Service_Assurance_Thresholds

CiscoSAA_Datapipe 5.8

CiscoSAA_NRT_Datapipe 2.4

ServiceAssuranceRFC2925_Datapipe 1.1 

6 Click Next. The Type Discovery window opens. Keep the default.

7 Click Next. The Selection Summary window opens.

8 Click Install. The Install Progress window opens and the installation begins. When the 
installation finishes, an install complete message appears.

If your system is distributed, the Location and Thresholds sub-packages 
belong on the central server only, not on satellite servers.
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9 Click Done to return to the Management Console. 

10 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start

Accessing Deployed Reports

When you installed this report pack, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms that come with this package) were deployed to 
the OVPI Application Server. Once reports and forms reside on the OVPI Application Server, 
you have two ways to view them:

• OVPI client applications

• Web browser

If you have the client applications, you have access to Report Viewer, Report Builder, and the 
Management Console. If you do not have the client applications, using a web browser to view 
reports is the only way you can view reports.

For more information about the clients, refer to the OVPI Installation Guide. For details 
about the Management Console, including how to use the Object/Property Management view 
to launch reports specific to a selected object, refer to the OVPI Administration Guide.

New Object Categories in the Object Model

An object is any item that has performance data associated with it. Devices, customers, and 
locations are object categories that belong to OVPI’s default object model. When you select an 
object in the object model, the right side of the Object/Property Management window 
refreshes, showing a list of forms under General Tasks, a list of forms under Object Specific 
Tasks, and a list of reports under Object Specific Reports. 

The object tree changes each time you install a new report pack. Some report packs will add a 
new class of objects or services that do not fit within the default model. When this happens, 
the report pack adds a new view. To open the new view, select View > Change View. 

Service Assurance adds the following object categories to the OVPI object model:

• SAA_Source

• SAA_Destination

• SAA_Application

Package Removal

Follow these steps to uninstall Service Assurance and the Cisco SAA Datapipe.

1 Log in to the system. On UNIX systems, log in as root.

2 Stop OVPI timer and wait for processes to terminate.
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Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Sun: sh /etc/init.d/ovpi_timer stop

3 Launch PI and start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click the Uninstall radio button.

6 Click Next. The Report Undeployment window opens.

7 Click the check box next to the following packages:

Service_Assurance

Service_Assurance_Location (if installed) 

Service_Assurance_NRT (if installed)

Service_Assurance_Thresholds (if installed) 

Service_Assurance_Demo (if installed)

CiscoSAA_Datapipe

CiscoSAA_NRT_Datapipe (if installed)

ServiceAssuranceRFC2925_Datapipe (if installed)

8 Click Next. The Uninstall Packages window opens.

9 Click Uninstall. The Progress window opens. When the removal finishes, a removal 
complete message appears. 

10 Click Done to return to the Management Console.

11 Restart OVPI Timer.

Windows: Select Settings > Control Panel > Administrative Tools > Services

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Sun: sh /etc/init.d/ovpi_timer start
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4 Router Configuration
The Cisco SAA Datapipe 5.0 supports the following SAA tests:

• Echo

• udpEcho

• tcpConnect

• HTTP

• DNS

• DLSw

• DHCP

• FTP

• Jitter

• MPLS VPN Aware Cisco IOS 12.2(2)T or later

• VoIP UDP (Cisco IOS 12.3(4)T or later

Although you can configure SAA tests using the Cisco IOS Command Line Interface and the 
SNMPSET command, these techniques are not that easy to use, especially when multiple 
routers are involved. To make this task easier and faster, use CiscoSAA_Config. This is a Perl 
module that functions as a batch-mode SAA test configuration utility for source routers. 

CiscoSAA_Config

CiscoSAA_Config resides inside the Cisco SAA Datapipe package. The full path is:

$DPIPE_HOME/packages/CiscoSAA_Datapipe/CiscoSAA_Config 

CiscoSAA_Config consists of two perl scripts and one XML file.

CiscoSAAConfig.pl. Perl script that reads an XML configuration file and sets SAA 
operations in a router.

CiscoSAADelete.pl. Perl script that deletes the SAA operations that were set by the 
CiscoSAAConfig script.

CiscoSAAConfig.xml. XML file that defines MIB values in the CISCO-RTTMON-MIB; 
includes some examples of SAA operations with nominal IP address. 

The following Perl modules are required to run this utility:

• Getopt::Std

• Cwd

• File::Spec 
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• Net::SNMP 

• XML::Simple

You should have no problem running CiscoSAA_Config on the OVPI server. To verify that no 
modules are missing and that all modules are correctly installed, run the following command:

perl –e “use Getopt::Std;use Cwd; use File::Spec; use Net::SNMP; XML::Simple”

Using an XML Block to Define an Operation

Each SAA operation is defined by an XML block. For each operation, only basic arguments are 
defined. Additional arguments can be defined based on the CISCO-RTTMON-MIB. The value 
of some arguments (excluding MIBName and ValueType) should be modified to fit your 
network and SAA target information. These arguments are located in the last few arguments 
in each operation block. 

For example, the following block defines an Echo operation:

<Operation Name="ECHO">

<!-- Following arguments cannot be modified -->

<OperationArg MIBName="rttMonCtrlAdminRttType" ValueType="i">1</
OperationArg>

<OperationArg MIBName="rttMonEchoAdminProtocol" ValueType="i">2</
OperationArg>        

<!-- Following arguments are required and must be modified -->

<OperationArg MIBName="rttMonEchoAdminTargetAddress" 
ValueType="d">192.15.115.22</OperationArg>    

<!-- Following arguments are optional and could be modified -->

<OperationArg MIBName="rttMonCtrlAdminTag" ValueType="s">SNMP_ECHO</
OperationArg>

<OperationArg MIBName="rttMonCtrlAdminThreshold" ValueType="i">1000</
OperationArg>

<OperationArg MIBName="rttMonCtrlAdminFrequency" ValueType="i">600</
OperationArg></Operation>

When you configure an Echo operation in your router using this example, you have to change 
the value of the rttMonEchoAdminTargetAddress to the IP address of your target device. 

Configuration Script Syntax

Use the main configuration script as follows:

Perl CiscoSAAConfig.pl -a router_address [-c community] [-f 
XML_config_file] [-m] [-h]

where:

• -a Cisco Router IP address, required argument

• -c read/write community string, default is private

• -f name of XML configuration file, default is CiscoSAAConfig.xml
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• -m enable writing the SAA probes into the non-volatile memory, default is 0 (false)

• -h help

Delete Script Syntax

The configuration script will hard-code the lifetime of all operations as forever. If you want to 
delete the SAA operations that have been set in the router, run the CiscoSAADelete.pl script. 
Use this script as follows:

Perl CiscoSAADelete.pl -a <router address> [-c <community>] [-b] [<SAA 
Test Index> ...] [-h]

Where:

• -a Cisco Router IP address, a required argument

• -c community string, default is private

• -b delete all SAA tests

• <SAA Test Index> delete one or more SAA tests

• -h help

If you do not enter an SAA index or use the -b option, the script will return all SAA indexes in 
the router. This is one way to find out which SAA tests have been configured. Once you know 
which SAA tests have been configured, you can use the SAA index value (the number after the 
last “dot” sign) to delete the SAA test you want to stop.

Other Approaches to Configuring SAA Tests

You have three other approaches to SAA test configuration:

• Command Line Interface (CLI)

• Cisco’s VPN Solution Center

• Cisco Works 

For more information about using the CLI, go here:

http://www.cisco.com/univercd/cc/td/doc/product/software/ios120/120newft/120t/
120t5/saaoper.htm

For more information about the VPN Solution Center, go here:

http://www.cisco.com/warp/public/779/servpro/operate/csm/nemnsw/vpn/prodlit/

For more information about Cisco Works, go here: 

http://www.cisco.com/warp/public/cc/pd/wr2k/index.shtml

If this option is set to 1, you must log in to the source router and enter the 
command write after this script runs.
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5 Package Configuration
This chapter covers the following topics: 

• Default thresholds in the Service_Assurance_Thresholds sub-package

• Using the Modify SAA Thresholds form to change default values

• Setting up a distributed system

You can modify the exception thresholds for all the devices owned by one customer, for all the 
devices in one location, for all the test operations initiated from one device, or for a subset of 
test operations initiated by one device belonging to one customer. 

Defaults in Service_Assurance_Thresholds

The Service_Assurance_Thresholds sub-package imposes thresholds for two MIB counters:

• Number of response time exceptions

• Number of test failures

The actual threshold for response time is controlled by Cisco IOS. To configure the threshold, 
use CiscoSAA_config, the test configuration utility described in the previous chapter. You will 
probably want to set this parameter on a test-by-test basis. For any one test, the threshold can 
vary from destination to destination.

The thresholds sub-package monitors the response time exceptions counter and the test 
failures counter. When either counter breaches the threshold, the thresholds sub-package 
sends a trap to the network management system. (If OVPI is currently integrated with 
Network Node Manager, the Thresholds Module will, by default, send threshold traps to your 
NNM server.) The following table indicates the default for each threshold category and the 
severity level for each threshold breach.

MIB Counter OVPI Threshold Condition for NNM Alarm Severity 

Response Time Exception Hour 75% of tests exceed the 
threshold for response time.

Minor

Exception Day 50% of tests exceed the 
threshold for response time.

Major

Test Failures Failed Hour 100% of tests failed. Warning

Failed Day 100% of tests failed. Critical
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The Thresholds Form

Service Assurance provides a form for modifying the default thresholds for:

• Exception Hour

• Exception Day

The other two fields in this form, Failed Hour and Failed Day, cannot be modified. Although 
there is only one form, the contents of the form will change depending on where you are in the 
object tree. The object tree provides these objects:

• Default [Device]

• Customer

• Location

You may apply your modification to all the devices belonging to one customer, to selected 
devices belonging to one customer, or to one device belonging to one customer. If you are 
modifying the thresholds for one device, you may apply the modification to every application 
(test operation) or to selected applications. 

Follow these steps to open the form: 

1 Start the Management Console.

2 Click Objects. In the Object/Property Management pane, navigate to a customer, a location, 
or a device. For each customer, your options are:

• Device

• SAA_Application

• SAA_Destination

• SAA_Source

3 Highlight an object. You will see the Modify SAA Thresholds form listed under Object 
Specific Tasks.

For details about the Thresholds Module, such as how to enable multiple 
types of traps or how to set up multiple trap destinations, refer to the 
Thresholds Module 5.1 User Guide.
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4 Double-click Modify SAA Thresholds. The form opens.

5 Modify one or both defaults. 

If you want to modify multiple, contiguous test operations, hold down the SHIFT key and 
use the mouse to highlight multiple test operations. If you want to modify individual test 
operations, hold down the CTRL key and use the mouse to select individual test 
operations.

6 Click Apply to save changes, OK to save changes and close the form, or Cancel to close the 
form without saving changes.
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Setting Up a Distributed System

These are the steps to follow when setting up a distributed system:

• Decide whether or not you want local reporting

• Install the right set of packages on each server (a central server that is not polling will not 
need datapipes; the satellite servers will need datapipes)

• Verify that the system clocks in your environment are synchronized

• Register your satellite servers

• If you are not copying rate data to the central server, enable LIR on the central server

• If you enable LIR, add LIR mapping with the time type set to rate

• Verify that you have all the copy policies you need

• Configure the central server (manual edits to trendtimer.sched and .pro files)

• Configure each satellite server (manual edits to trendtimer.sched and .pro files)

If you want to set up a distributed system, you can implement local reporting or you can 
implement centralized reporting. If you want local reporting, you need to deploy reports when 
you install the report pack on each satellite server, and you need to allow summarizations to 
run on each satellite server. If you do not want local reporting, then you do not need to deploy 
reports when you install a report pack on a satellite server and you can disable the scripts 
that run summarizations on each satellite server.

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. The advantage to this approach was that it kept a large 
volume of rate data off the network and it decreased the processing load on the central server. 
The disadvantage is that the central server could not display a Near Real Time (NRT) report. 
The only NRT report was a local NRT report, on a satellite server. LIR overcomes this 
disadvantage. If you enable LIR, you can open an NRT report on the central server and 
drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do that, then enabling LIR is not necessary.

Proper Package Installation

Use the following table to verify that datapipes and optional packages are installed where 
they need to be installed. At least one datapipe must be installed on each satellite server. 

Central Server Satellite Server 

Service Assurance Service Assurance 

Common Property Tables Common Property Tables

Thresholds Module (optional) Cisco SAA Datapipe

Service_Assurance_Thresholds (optional) Cisco NRT SAA Datapipe
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Typically, the central server does not poll. If you want the central server in your system to 
poll, then you must install one or more datapipes on the central server. 

If you are only interested in setting thresholds on hourly data or rate data, you do not need to 
install the thresholds sub-package on the central server. If you are interested in setting 
thresholds for aggregated data (for example, summary data of any kind, or a forecast) then 
you need to install Service_Assurance_Thresholds on the central server.

Configuring the Central Server

To configure the central server, perform the following tasks:

• Task 1: Register the satellite server by setting the database role

• Task 2: If you are not copying data to the central server, enable LIR

• Task 3: If you enable LIR, add LIR mappings

• Task 4: Verify the automatically generated copy policies

• Task 5: Modify the trendtimer.sched file

Task 1: Register the satellite server by setting the database role

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the database system.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

Service_Assurance_Location (optional) Service Assurance RFC2925 Datapipe

Service_Assurance_NRT (optional) Service_Assurance_NRT (optional)

Central Server Satellite Server 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application.
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3 Navigate to the OVPI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select Service Assurance from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 If you want to add additional LIR mappings, click Add to list and repeat step 6 through 
step 10.

12 Click OK.

13 Click Apply.

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied that is defined in the generated copy policy (the type of data copied 
that is defined in the generated copy policy is for one greater than the data type selected in 
the LIR mapping). For example, if you select an hourly data type, a daily data copy policy is 
generated.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 Find the following tables and verify the copy type is set to Property and Data for each 
table:

• SHSAA

• SHSAA_jitter

If a copy policy has not been generated for a table, do the following:

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays.

2 Click Next. The Satellite Server and Copy Policy Selection Page displays.

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

4 Select Single Table and select the table from the pull down list.

5 Click Next. The Copy Type Selection Page displays.

6 Select Property and Data.

7 Click Next. The Summary page displays.

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.

9 Click Finish.
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10 Repeat step 4 - step 9 for all missing tables.

If the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Modify the trendtimer.sched file

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change to this file:

• Find and comment out the following line:

1:00+40 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/Service_Assurance_Hourly.pro

Configuring a Satellite Server

Follow these steps to configure each satellite server.

1 Modify the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is the 
directory in which OVPI is installed):

• Find and comment out the following line to switch off daily aggregations:

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f  
{DPIPE_HOME}/scripts/Service_Assurance_Daily.pro

2 Modify the Service_Assurance_Hourly.pro file.

The Service_Assurance_Hourly.pro file is found in the {DPIPE_HOME}/scripts/ 
directory where {DPIPE_HOME} is the directory in which OVPI is installed.

Make the following change:

• Find and uncomment the following lines:

begin:block2 wait

end:block2

3 Configure polling policies for the Cisco SAA Datapipe. Make sure that each SAA router is 
polled by only one satellite server.

System Clocks

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server.
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6 Ranking Exception Counts
The exception reports rank elements according to yesterday’s exception count. Use the 
exception reports to drill down from elements with relatively high exception counts to the 
specific element pairs that are causing the exceptions. There are six exception reports:

• Source Exception Report, by Application/Destination

• Destination Exception Report, by Source/Application

• Destination Exception Report, by Location/Application

• Application Exception Report, by Source/Destination

• Application Exception Report, by Location/Destination

• Location Exception Report, by Source/Destination

The customer selection table ranks customers by number of exceptions. The next table is a list 
of elements, also ranked by number of exceptions. The third selection table provides a list of 
element pairs, for example, source and destination pairs, or location and destination pairs, 
that contributed to the exception total. The history graphs to the right compare yesterday’s 
activity to the previous 30 days. 

The bottom table and the graphs below the bottom table focus on one specific element pair, 
from one perspective, for one customer. The graphs provide hourly data for yesterday and 
daily data for the previous 90 days. The following table outlines the scope of each graph.

Samples of three exception reports follow: (1) Destination by Source/Application, (2) Source by 
Application/Destination, and (3) Application by Source/Destination.

Hourly/Daily Graph What it Tracks

Response time Minimum, average, and maximum response time. 

Throughput Minimum, average, and the maximum throughput. 

HTTP Response Time DNS lookup time + TCP connection time + HTTP 
transaction time. Applies to HTTP tests only.

Exception Counts Total number of response time exceptions.

Number of Transactions Total number of transactions.

Availability The end user’s perception of destination availability. 
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7 Aggregating Performance Data
Summary reports look at aggregations of data. For example, if you are looking at the 
destination summary, the statistics for each destination bring together individual statistics 
for each source and each SAA test that was initiated by the source. The data that is brought 
together for the destination is either a total or an average. These are totals compiled from 
multiple sources:

• Number of transactions

• Number of bytes

These are averages based on results from multiple sources:

• Response time

• Throughput

• Availability

Use summary reports to find out whether recent activity appearing in a Top Ten report is a 
temporary condition with no history behind it, or a longer term trend that you may need to 
investigate more closely. The Service Assurance package includes one summary report for 
each of the following perspectives: 

• Source

• Destination

• Application

• Location

• Customer

• Source / Destination / Application

Most summary reports have two selection tables. The Customer Summary has one selection 
table and the Source Summary by Application/Destination has three selection tables. The 
third selection table lists all application/destination pairs associated with the selected source. 
The Source Summary by Application/Destination provides the greatest amount of detail, since 
it is looking at performance from the source-destination-application perspective. 

See below for samples of the following reports: 

• Destination Summary

• Application Summary

• Source Summary by Application/Destination
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8 Forecasting Future Performance
Forecast reports alert you to elements (customers, applications, sources, destinations, and 
locations) that may be headed for response time or throughput problems. This report comes in 
two styles: short and long. The following short-version reports let you drill down from 
customers to elements that belong to a particular customer: 

• Application Forecast

• Source Forecast

• Destination Forecast

• Location Forecast

• Customer Forecast

The following long-version reports let you drill down to specific element pairs:

• Application Forecast by Source/Destination

• Application Forecast by Location/Destination

• Source Forecast by Application/Destination

• Destination Forecast by Source/Application

• Destination Forecast by Location/Application

• Location Forecast by Application/Destination

The first table sorts customers by F90 Response Time, highest to lowest. The second table 
sorts elements by the rate at which response time is increasing or the rate at which 
throughput is decreasing. The graphs provide three views of response time and throughput:

• Bar chart that compares F30 to F60 and F90

• Table showing aggregations by day of week

• Line graph tracking historic trends

See below for samples of the following reports:

• Destination Forecast

• Application Forecast

• Application Forecast by Source/Destination
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9 Ranking the Worst Performers
A top ten report performs a ranking function for yesterday’s collection of test results. Use this 
type of report to identify potential problems related to response time, throughput, transaction 
counts, or traffic volume. Service Assurance contains five top ten reports:

• Application

• Customer 

• Destination 

• Location

• Source 

Except for the Customer Top Ten, which is slightly different, each reports contains a customer 
table followed by ten tables with ten entries in each table. The tables are:

• Worst response time

• Response time increase

• Worst throughput

• Throughput increase

• Most transactions

• Most traffic

See below for samples of the following reports:

• Application Top Ten

• Destination Top Ten
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10 Sampled Data in Near Real Time
The reports in previous chapters look back in time, to what happened yesterday, last week, 
last month — and forward in time, to what is expected to happen in the future. The Near Real 
Time (NRT) reports look at data collected over the last six hours.

If you install one datapipe only, the Cisco SAA Datapipe, you will have one NRT report, the 
NRT Summary. This report is inside the Source/Destination/Application folder. The contents 
of this report come from data stored by SAA in the MIB History Table. This report changes 
once an hour. Use this report to identify:

• Source / destination / application combinations with high exception counts

• Availability percentage for each combination

The NRT Summary includes any combination that experienced activity during the last six 
hours, not just combinations that reported exceptions. If an exception count looks unusual, 
and you want to know how NRT performance compares with past performance, inspect the 
following graphs, tabbed Last 24 Hours and Last 30 Days:

• Response time

• Throughput

• Transactions

• Exception Counts

• Availability

• Traffic

If you install the Cisco SAA NRT Datapipe, you get three additional NRT reports:

• Near Real Time - Latest Test

• Jitter Near Real Time - Latest Test

• VoIP Near Real Time - Latest Test

The contents of these reports come from data stored by SAA in the Latest Test Table. How 
often the contents of these reports are updated depends on how frequently the Cisco SAA NRT 
Datapipe polls the Latest Test Table. The maximum frequency is once every 5 minutes. See 
below for samples of NRT Summary, Jitter NRT - Latest Test, and VoIP NRT - Latest Test.

Cisco modified the way it records MOS values. The original value range went from 1 to 5. 
According to Cisco revision 200305210000Z, the range is now 100 to 500. The VoIP Near Real 
Time - Latest Test report includes a chart that tracks MOS over the previous 24 hours for a 
selected SAA test. The range of values in the graph will vary from original range to new 
range depending on which version of the CISCO-RTTMON-MIB is being polled by the Cisco 
SAA NRT Datapipe. 
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11 Monitoring Jitter
When a Service Assurance Agent conducts a jitter test, it sends synthetic UDP traffic from the 
source device to a destination device and back again to the source device. A jitter test produces 
the following statistics:

• Variation in the inter-packet delay in each direction

• Number of lost packets in each direction

• Number of packet sequence errors in each direction

• Round trip time

Service Assurance contains the following jitter reports:

• Jitter Source Summary

• Jitter Destination Summary

• Jitter Source-Destination Summary

Jitter reports highlight the number of jitter tests that took place yesterday and the number of 
response time exceptions that were recorded for each customer. From the customer table you 
can drill down to investigate delay variance and response time on a device-by-device basis. If 
the deviation or the response time for a device looks suspicious, you can investigate further by 
viewing hourly and daily data graphs for response time, types of packet errors, deviation, and 
packet loss.

Samples of all three jitter reports follow.
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A Version History
Version Release Date Enhancements

1.0 May 2003 32 reports
Sybase support

2.0 October 2003 OVPI Object Manager support
MPLS VPN Aware Test
Modify SAA Thresholds (form)

3.0 April 2004 Oracle support
Minor changes to property table
Minor changes to existing reports
Removal of obsolete TEEL directives
new datapipe:
• CiscoSAA_NRT_Datapipe
new sub-package:
• Service Assurance NRT 1.0:

— NRT - Latest Test 
— Jitter NRT

3.0 August 2004 Service_Assurance 3.0
Service_Assurance_Location 3.0
new upgrade packages:
• UPGRADE_Service_Assurance_to_3
• UPGRADE_Service_Assurance_Location_to_3

3.0 November 2004 Service_Assurance_NRT 2.0:
• VoIP NRT - Latest Test (new report)
• Changes to NRT Latest Test:

— Location
— ToS
— Tag

• Changes to Jitter NRT:
— Location
— ToS
— Tag
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3.0 November 2004 CiscoSAA_Datapipe 5.5: 
•  Improved performance of stored procedures
•  Support VoIP test (MOS data collection)
CiscoSAA_NRT_Datapipe 2.0: 
•  Improved performance of stored procedures
•  Support VoIP test (MOS data collection)

3.0 June 2005 CiscoSAA_Datapipe 5.6 
CiscoSAA_NRT_Datapipe 2.1

3.0 March 2006 CiscoSAA_Datapipe 5.7
UPGRADE_CiscoSAA_Datapipe_to_57
Cisco SAA_NRT_Datapipe 2.2

3.0 May 2006 CiscoSAA_NRT_Datapipe 2.3
UPGRADE_CiscoSAA_NRT_Datapipe_to_23
RFC2925 Datapipe 1.0

3.1 April 2007 new features:
• Location Independent Reporting (LIR)
• Supports Management Console > Copy Policy Manager

• Rate data removed from NRT reports, table at top
• Report format updates
new upgrade packages:
• UPGRADE_Service_Assurance_to_31
• UPGRADE_Service_Assurance_Location_to_31
• UPGRADE_Service_Assurance_NRT_to_21
• UPGRADE_CiscoSAA_Datapipe_to_58
• UPGRADE_CiscoSAA_NRT_Datapipe_to_24
• UPGRADE_ServiceAssuranceRFC2925_Datapipe_to_11
fixes the following defect: 
• QXCR1000348212

3.1 October 2007 new prerequisites:
• PI 5.3
• Common Property Tables 3.7

Version Release Date Enhancements
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B Editing Tables and Graphs
Any table or graph can be viewed in several ways. Although the default view is usually 
adequate, you can easily change to a different view. If you are using Report Viewer, right-click 
the object to open a list of view options. If you are using the Web Access Server, follow these 
steps to change the default view of a table or graph:

1 Click Preferences on the links bar.

2 Expand Reports in the navigation frame.

3 Click Viewing.

4 Select the Allow element editing box.

5 Click Apply.

6 Click the Edit icon next to the table or graph. 

View Options for Tables

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options.

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens.

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time.

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering 
the number of elements that conform to the constraint. The Change Constraint Values 
window opens. To loosen a constraint, set the value lower; to tighten a constraint, set the 
value higher.

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens.
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If 
you expand the default, the table may take more time to open. If you are trending a large 
network, using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option.

Style Options

Select Style to display a list of seven view options for graphs.

Option Function

Set Time Period Same as the table option shown above.

Change Constraint Values Same as the table option shown above.

Select Nodes/Interfaces Same as the table option shown above.

Displayed Data For every point on a graph, display data in a 
spreadsheet.

Grid Add these to the graph:
X axis grid lines
Y axis grid lines
X and Y axis grid lines

Legend Delete or reposition the legend. 

Style See the illustrations below.

Change Max Rows... Same as the table option shown above.

Display Data Table See below.

Export Element as CSV... Same as the table option shown above.

View in New Frame Opens graph in a Graph Viewer window.

Print Graph Same as the table option shown above.
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Style > Area

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span.

Style > Stacking Area

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables.
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Style > Bar

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below.

Style > Stacking Bar

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten.
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Style > Plot

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers.

Style > Pie

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day.

If you are looking at data for more than one day, you will see multiple pie graphs, one for each 
day. 
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Display Data Table

This option changes a graph into a spreadsheet. 

View in New Frame

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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Index
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alarm severity, 31

Application Exception Report, by Location/
Destination, 39

Application Exception Report, by Source/
Destination, 39

Application Forecast, 57

Application Forecast by Source/Destination, 57

Application Summary, 49

Application Top Ten, 63

availability, 10

Average round-trip time, 10

C
change max rows option, 89

Cisco_SAA_NRT_Datapipe, 24

Cisco IOS Command Line Interface, 27

CiscoSAA_Config, 27

CiscoSAAConfig.pl, 27

CiscoSAAConfig.xml, 27

Cisco SAA Datapipe, 9, 10, 24, 27

CiscoSAADelete.pl, 27

Cisco SAA NRT Datapipe, 9, 10

Cisco VPN Solution Center, 29

collection_manager (command), 16

Common Property Tables, 15, 22

configuring SAA operations, 10

configuring source routers, 32

Copy Policy Manager, 36

customer-specific reports, 13

Customer Top Ten, 63

custom views of data or property tables, 16

D
Datapipe Manager, 17

defining an SAA operation, 28

demo package, 14, 24

Destination Exception Report, by Location/
Application, 39

Destination Exception Report, by Source/
Application, 39

Destination Forecast, 57

Destination Summary, 49

Destination Top Ten, 63

Display Data Table, 89

displayed data option, 89

distributed systems, 17, 22

E
editing parameters, 14

exception count, 10

exception reports, 39

F
forecast reports, 57

G
grid options, 89

group_manager (command), 16

group filters, 13, 31

H
History-related statistics, 10

History Table (MIB), 10

I
ICMP ECHO test, 10

J
Jitter Near Real Time - Latest Test, 69

Jitter Summary Report, 77
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L
Latest Test Table (MIB), 10

legend options, 89

LIR Configuration, 35, 36

Location Exception Report, by Source/Destination, 
39

M
MOS, 8, 9, 69

N
Near Real Time - Latest Test, 69

Near Real Time Summary, 69

NRT reports
Jitter NRT - Latest Test, 69
NRT - Latest Test, 69
NRT summary, 69

O
object categories, 25

P
polling policies, 16

R
report parameters, 32

RFC2925 Datapipe, 9

S
SAA_Application (object model), 25

SAA_Destination (object model), 25

SAA_Source (object model), 25

sample data, 69

satellite servers, 37

script syntax for CiscoSAA_Config, 28

Service_Assurance_Hourly.pro, 37

Service_Assurance_Locations 3.1, 24

Service_Assurance_Thresholds (module), 24

Service Assurance NRT 2.0, 17

Service Assurance RFC2925 Datapipe, 10

Source Exception Report, by Application/
Destination, 39

Source Summary by Application/Destination, 49

style options for graphs, 89

summary reports, 49

Sum of square of round-trip time, 10

system clocks, 31, 37

T
threshold conditions, 31

throughput between devices, 10

top ten reports, 63

trendtimer.sched, 37

U
UPGRADE_Service_Assurance_to_31, 19

Use Absolute Time, 87

V
view in new frame, 88
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